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1 INTRODUCTION 

1.1 THE MOTOR VEHICLE EMISSIONS INVENTORY 

An emissions inventory is a critical element in the control of air pollution and the 
attainment of national and state ambient air quality standards.  It is also an essential 
tool in developing regulations and control strategies to fulfill the California Air Resources 
Board’s (CARB) mission to promote and protect public health, welfare, and ecological 
resources through the effective and efficient reduction of air pollutants while recognizing 
and considering the effects on the economy of the state. 

An emissions inventory (for any source category) can be calculated, at the most basic 
level as the product of an emission rate, expressed in grams of a pollutant emitted per 
some unit of source activity, and a measure of that source’s activity. The following 
expression illustrates this basic relationship between the emissions rate and source 
activity used to calculate emissions: 

Emission Factor X Source Activity = Emissions 

For on-road motor vehicles, emissions rates are typically expressed as mass of 
pollutant emitted per mile driven, per vehicle per day, or per trip made, depending on 
the emissions process being analyzed.  An emissions process for a motor vehicle is the 
physical mechanism that results in the emissions of a pollutant (e.g., the combustion of 
fuel, the evaporation of fuel, tire or brake wear, or the start of an engine). 

CARB developed an EMission FACtors (EMFAC) model to calculate statewide or 
regional emissions inventories by multiplying emissions rates with vehicle activity data 
from all motor vehicles, including passenger cars to heavy-duty trucks, operating on 
highways, freeways, and local roads in California. 

1.2 EMFAC2021 

Over the years, tougher emissions standards have been met with technological 
solutions of increasing complexity. As a result, the emissions estimation models have 
also grown in size and complexity. 

EMFAC2021 is the latest emissions inventory model that calculates emissions 
inventories for motor vehicles operating on roads in California. EMFAC2021 represents 
the next step forward in the ongoing improvement process for EMFAC, and reflects the 
CARB’s current understanding of how vehicles travel and how much they pollute. The 
EMFAC2021 model is needed to support CARB’s planning and policy development 
efforts and to meet the Federal Highway Administration’s transportation conformity 
requirements. 
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The EMFAC2021 model can be used to show how California motor vehicle emissions 
have changed over time and are projected to change in the future. This information 
helps CARB evaluate prospective control programs and determine the most effective, 
science-based proposals for protecting the environment. 

EMFAC2021 includes the latest data on California’s car and truck population, activity, 
and emission testing.  New forecasting frameworks have been incorporated to project 
zero-emission vehicle (ZEV) population, and to estimate heavy-duty vehicle miles 
traveled.  New model features are added to reflect the more fuel and technologies, 
including modules to show emissions from Plug-in Hybrid Electric Vehicles (PHEV) and 
natural gas trucks, as well as energy consumption from ZEVs.  Heavy-duty truck 
categories have been expanded to show more vocational types. A new pollutant, 
ammonia (NH3) is added to support air quality modeling. EMFAC2021 also 
incorporates all the most recently adopted on-road mobile source regulations. More 
details about the updates in emissions calculation methodologies and data are available 
in the EMFAC2021 Technical Documentation. 

Figure 1-1 displays a flow chart indicating the GUI selections necessary to generate the 
various outputs of EMFAC2021. The Emissions Mode can be used to estimate tons of 
emissions per day and the Emission Rate Mode can be used to estimate grams of 
emission per unit of activity. The Custom Activity (SG) mode can be used to estimate 
tons of emission per day with customized activity from the end-users. 

Figure 1-1. EMFAC2021 Overall Flow 
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IMPORTANT! – “Custom Activity (SG)” Mode 

The Custom Activity Mode (discussed in detail in Chapter 5.2) provides the end-user flexibilities 
to input different level of vehicle activity and technology mix. Besides two specific types of 
assessments: conformity assessments and SB375 assessments, EMFAC2021 has extended 
the functionality of the SG mode. It allows users to develop emission scenarios by varying not 
only the total vehicle miles traveled by vehicle categories, but also changing the technology mix 
of different fuel types (e.g. natural gas, electric, and diesel). The SG mode of EMFAC2021 
outputs all the available fuel types in the model, including gasoline, PHEV, diesel, natural gas, 
and electric. 

For conformity assessments, emissions are estimated with all current on-road mobile source 
regulations (see EMFAC2021 Technical Documentation for details). For SB375 assessments, 
the Advanced Clean Cars (ACC)/Pavley/SAFE Vehicle rules are deactivated.  Because the ACC 
regulation has certain assumptions about vehicle usage built into it, default data in custom 
activity templates produced for conformity assessments will not match the default data in 
templates for SB375 assessments. For the same reason, estimates of CO2 will also differ. 

1.3 ABOUT THIS DOCUMENT 

The purpose of this EMFAC2021 User’s Guide is to familiarize users with the features 
and controls in the EMFAC2021 model.  More information regarding the methodologies 
and data used in EMFAC2021 to estimate emissions and emission rates will be made 
available in the EMFAC2021 Technical Documentation. 
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2 POLLUTANTS, ACTIVITIES, AND PROCESSES MODELED 

This section describes the pollutants and emissions processes currently modeled in 
EMFAC2021. 

2.1 POLLUTANTS 

The model calculates emissions factors and emissions inventories for the following 
primary pollutants: 

• Carbon monoxide (CO) 
• Nitrogen oxides (NOx) 
• Hydrocarbons (HC): HC can be expressed as TOG (total organic gases), ROG 

(reactive organic gases), THC (total hydrocarbon), or CH4 (methane).  The THC 
class includes compounds with H and C atoms only, carbonyls and halogens 
are not included in the class. The TOG class includes all organic gases emitted 
into the atmosphere. The ROG class is the same as EPA’s Volatile Organic 
Compounds (VOC) definition and does not contain compounds exempt from 
regulations. 

• Particulate matter (PM): Particulate matter estimates are provided for total 
suspended particulates (PM), with diameter 10 microns or less (PM10), and with 
diameter 2.5 microns or less (PM2.5). 

• Sulfur oxides (SOx): Emissions of oxides of sulfur are a function of the sulfur 
content of fuel.  The model calculates these emissions by multiplying the fuel 
consumption by the weight fraction of sulfur in a gallon of fuel. 

• Fuel:  Although fuel is not a pollutant, fuel consumption is calculated based on 
the tailpipe emissions of CO, CO2 and THC using the carbon balance equation. 

• Greenhouse Gases (GHG): GHG emissions consist of complete combustion 
CO2, Nitrous Oxide (N2O) and Methane (CH4). These are the greenhouse 
gases that are included starting from EMFAC2017. 

• Ammonia (NH3): NH3 is a newly added pollutant in EMFAC2021. Emission rates 
of NH3 vary by vehicle class and model year. 

2.2 ACTIVITIES 

The model estimates and projects vehicle activities and outputs them for the following 
activities: 

• Vehicle Miles Traveled (VMT): daily VMT is generated in three types, including 
total VMT, cVMT, and eVMT. The latter two are newly added in EMFAC2021.  
cVMT represents conventional VMT which is powered by conventional fuel, e.g. 
gasoline, diesel, or natural gas.  eVMT represents electric VMT, which is 
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powered by battery or electricity. Total VMT is the sum of cVMT and eVMT. 
Only PHEV has both cVMT and eVMT, and the rest of fuel types have either 
cVMT (gasoline, diesel, and natural gas), or eVMT (electric) 

• Trip: EMFAC defines a trip as an engine-on event. The total number of trips is 
estimated by number of starts per vehicle and vehicle population. Unlike 
internal combustion engine (ICE) vehicles, PHEVs can use energy from a 
battery, an ICE or a combination of the two to attain propulsion power, and they 
could invoke the engine at any moment within a given trip. The PHEV trip 
output only includes trips with engine-on events. 

• Population 
• Energy Consumption: Energy or electricity consumption is a newly added output 

in EMFAC2021 and is generated in a separate .csv file, similar to other activity 
outputs (e.g. VMT, trip, and population). It is estimated based on electricity 
consumption in kilowatt-hour (kWh) per mile. 

2.3 EMISSIONS PROCESSES 

Emissions (especially HC) emanate from a vehicle during all hours of the day.  The 
magnitude of these emissions varies with what is happening with the vehicle, such as 
running on the road, idling at a loading zone, sitting outside in the sun, or just starting. 
Emissions processes account for all emissions of a vehicle across all hours of the day, 
regardless of whether the vehicle is in motion or whether or not it has been started. The 
types of emissions processes in the model are: 

• Running Exhaust Emissions (RUNEX) that come out of the vehicle tailpipe while 
traveling on the road. 

• Idle Exhaust Emissions (IDLEX) that come out of the vehicle tailpipe while it is 
operating but not traveling any significant distance. This process captures 
emissions from heavy-duty vehicles that idle for extended periods of time while 
loading or unloading goods.  Idle exhaust is calculated only for heavy-duty 
trucks. 

• Start Exhaust Tailpipe Emissions (STREX) that occur when starting a vehicle. 
These emissions are independent of running exhaust emissions and represent 
the emissions occurring during the initial time period when a vehicle’s emissions 
after treatment system is warming up. The magnitude of these emissions is 
dependent on how long the vehicle has been sitting prior to starting. Please 
note that STREX is defined differently for heavy-duty diesel trucks than for other 
vehicles.  More details can be found in the EMFAC2014 Technical Support 
Document. 

• Diurnal Evaporative HC Emissions (DIURN) that occur when rising ambient 
temperatures cause fuel evaporation from vehicles sitting throughout the day. 
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These losses are from leaks in the fuel system, fuel hoses, connectors, as a 
result of the breakthrough of vapors from the carbon canister. 

• Hot Soak Evaporative HC Emissions (HOTSOAK) that begin immediately from 
heated fuels after a car stops its engine operation and continue until the fuel 
tank reaches ambient temperature. 

• Running Loss Evaporative HC Emissions (RUNLOSS) that occur as a result of 
hot fuel vapors escaping from the fuel system or overwhelming the carbon 
canister while the vehicle is operating. 

• Tire Wear Particulate Matter Emissions (PMTW) that originate from tires as a 
result of wear. 

• Brake Wear Particulate Matter Emissions (PMBW) that originate from brake 
usage.  

10 



 
 

 
 

   

  
     
   

    
    

 
      

  
   

    
  

 
   

  
   
   

  
       

   
  

 

   
         

      
 

    
    

 

 

 
 

 
 

EMFAC2021 User’s Guide 

3 INSTALLATION AND CONFIGURATION OF EMFAC2021 

3.1 SYSTEM REQUIREMENTS 
• Operating System: Microsoft Windows 10 
• Disk Storage: 
o EMFAC2021 application itself requires 1 GB disk space. 
o The default MySQL database used by EMFAC2021 will require 5 GB disk 

space. 
o At least, 50 GB of free disk space is recommended for running EMFAC2021. 

The amount of space required varies depending on the level of detail in the 
output, the number of sub-areas and calendar years, and the number of runs. 

o The performance of EMFAC2021 depends on the performance of MySQL 
server. For fast EMFAC runs, we recommend running MySQL server on a 
computer with multiple CPU cores and a high-performance storage (e.g. Solid 
State Drives). 

• EMFAC2021 was tested on the following system 
o Processor: Intel® Core™ i7-8665U 
o Memory (RAM): 16.00 GB 
o Windows Edition: Windows 10 Enterprise Version 1909 

3.2 PRE-INSTALLATION NOTES 
• EMFAC2021 requires MySQL Community Server 8.0. Other versions are not 

officially supported. You can find more information about getting and installing 
MySQL software at the official MySQL website: https://www.mysql.com 

Note! 

Please do not make any changes to the EMFAC default 
database on the MySQL server.  The model may fail or 
generate erroneous results if changes are made to the 
database. 

3.3 MODEL INSTALLATION 
1. Extract the EMFAC2021 package to a folder of your choice on your local drive. 

This user’s guide assumes the package is extracted or copied to the C: root 
directory. 

2. Right click on “EMFAC.exe”, in the installation directory 
("C:\EMFAC2021\EMFAC.exe") to create a shortcut or pin it to the taskbar or 
the start menu. 
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3.4 MODEL CONFIGURATION 
1. Double click “EMFAC.exe” within the installation directory, or click the icon on 

the taskbar or start menu, to start EMFAC2021.  The program will display a 
page that asks users to configure MySQL settings first using the MySQL 
Configurator. You may safely ignore any Microsoft Windows security or 
antivirus warning related to the EMFAC2021 software package. 

2. Click the “Configure MySQL” button to bring up the pop-up window shown 
below. This configuration is needed for the installation of an updated model or 
when the configuration of MySQL is changed. 

3. Enter the “MySQL Username”, “MySQL Password” of your MySQL. 
4. Enter the “MySQL DB Prefix” with the prefixes that you would like to see in the 

names of schemas. 
5. A suggested value of “# of parallel MySQL” is provided to avoid conflicts 

between existed schemas. User can change it based on the number of CPU 
cores in your MySQL server. 

6. Keep “Host,” “Port,” and “Username” unchanged, and the “Password” will be 
the one you supplied upon installation of MySQL for the root account. 

7. Click “Test” to test the configuration. 
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8. Click “Save” only when both the connection and directory are set correctly. 
Repeat the configuration steps if any mistake is made. 

9. Click “Import EMFAC Default Database” to import the databases to your 
MySQL server. 

10.Please note that a user can reconfigure a previously configured 
EMFAC2021/MySQL connection by launching the MySQL Configurator from 
the Tools menu. This functionality could be used, for instance, to connect the 
model to a different MySQL server. 

11.Once the import is finished, click “Click to Get Started” to enter the main menu 
of EMFAC2021. 
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4 GETTING STARTED WITH EMFAC2021 

4.1 GENERAL TIPS 
• The console shows the status of the model and error messages, if any. 
• Consecutive items can be selected by shift-clicking and non-consecutive items 

can be selected by control-clicking in the list boxes. 
• The unit for fuel output is 1000 gallons/day. The fuel unit for natural gas 

vehicles is in diesel equivalent gallon (DEG). 
• The unit for energy consumption is kWh per day. 
• The unit for all pollutants in the emissions inventory is tons/day. 
• The units for the output of the GHG module are detailed as follows. Column 

“emission”: in tons/day (and in thousand gallons/day where the "pollutant" is 
Fuel). Column “emission_annualized”: in tons/year (and in thousand 
gallons/year where the "pollutant" is Fuel). Column “CO2e”: in tons/day. 
Basically, it is to be consistent with the EMFAC model's historical convention; 
e.g. ., all emissions are in short tons and fuel consumption is in thousand 
gallons. There is only one column which is special with the GHG module, e.g., 
column “CO2e_annualized” in metric tons per year. This is to facilitate 
comparison with existing literature which reports CO2e using metric tons or even 
million metric tons such as those in Scoping Plan. Note that 1 ton = 0.907185 
metric tons. 

• In order to manage the size of the output files, some emissions and emission 
rates that are equal to zero are not included in the output files. Therefore, in 
instances when data are missing in the output file, the user can assume zero 
emissions or an emission rate of zero. The program is best viewed with 
"Smaller" text size on Windows. The “Smaller” text size is used by most people, 
and can be set within the Control Panel\Appearance and 
Personalization\Display 

• When canceling a run, the program will try to terminate all the active queries, 
some may not stop immediately. But pressing the cancel will not remove the 
main GUI and the console. It only removes the running dialogue. 

• Use the method described in Appendix 1 to estimate the disk space needed 
before starting a run to make sure there is enough free disk space to finish the 
run. 
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Note! 
1. Do not close the console while the model is running. 
2. Limit the number of areas and calendar years and level of 

details selected for one run to manage the run-time of the 
current run and the size of the output. 

3. Splitting big runs into small runs is strongly recommended. 

4.2 GRAPHICAL USER INTERFACE 

MENUS 

• There are four menus in the parent, Home Screen window of EMFAC2021: 
“File”, “Run”, “Tools” and “Help”. 

• The File Menu has four actions: “New” (new run), “Open” (open a saved run 
specification), “Save” (save a run specification), and “Exit.” Upon starting the 
program, the program automatically assumes the user is creating a new run and 
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thus the parent window displays the Home Screen. One may choose to open a 
previous run by selecting “Open” in the File Menu and then selecting the 
appropriate file. 

• The Exit action of the File Menu will only work in EMFAC2021 if a calculation is 
not being made.  If calculations are occurring, cancel the run first, and then exit. 

• The Run Menu has one action: “Run EMFAC.” 
• The Tools Menu has one action: “MySQL Configurator.” 
• The Help Menu has an “About…” action that will tell the user which version of 

the model is running. 

HOME SCREEN, RUN MODES AND TYPES 

• The Home Screen (below) is automatically displayed after the model starts or 
when “New” is selected from the File Menu. 

• “Run Mode” and “Run Type” are the selection options in this “New” tab. There 
are two different Run Modes: “Emissions” and “Emission Rates.” 

• Under the “Emissions” run mode, two Run Types are available. “Default Activity” 
runs use default EMFAC activity data, while the “Custom Activity (SG)” run type 
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allows the users to use their own activity data to run the model. The “Custom 
Activity (SG)” run type was formerly known as “SG” or “Scenario Generator”. It 
can be used to generate an input activity data file template or to load custom 
activity data to produce an emissions inventory for transportation planning, a 
SB375 report, etc. 

• Under the “Emission Rates” run mode, only one Run Type is available. The 
‘’Project-Level Assessment (PL)” run type can be used to calculate emissions 
rates with inputs of meteorological conditions for project-level assessments. 
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5 GENERATING EMISSIONS INVENTORIES 

For regional analyses (as opposed to project-level analyses), there are two different 
modes in EMFAC2021 dictated by the travel activity data that are used. 

Default Activity Mode. EMFAC2021 uses historical fuel sales to estimate VMT as its 
default activity to facilitate fuel-based inventory analyses.  

Custom Activity (SG) Mode.  It is necessary to use the latest regional vehicle activity 
data developed by local planning agencies to generate the regional on-road emissions 
for State Implementation Plans (SIPs). Thus, for SIP criteria pollutant (planning 
inventory) analyses, EMFAC2021 allows the user to replace the fuel-based default data 
with user-supplied data from metropolitan and regional planning agencies. 
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5.1 USING DEFAULT ACTIVITY MODE 

In this section, we explain how to accomplish a Emissions run with Default Activity, 
which is typically performed for fuel-based emissions inventory analyses, either from the 
Home Screen or by loading an EMFAC2021 “.ers” file, saved from a previous run. The 
run parameters for default emissions run are summarized in Appendix 2. 

STARTING A DEFAULT ACTIVITY RUN 

1. Go to the Home Screen by either restarting the model or clicking “New” in the 
File Menu. 

2. Pick “Emissions” and “Default Activity” and click “Start”. 
• This takes the user to a window with four tabs (next page); the Area Tab, 

the Time Tab, the Vehicles Tab, and the Output Tab. 
• Each tab presents options for the user to customize for the model run 
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AREA TAB 

• The Area Tab’s list boxes allow the user to choose different area types and 
areas for analysis (note the “Area” tab is highlighted below). The user may pick 
from one of six area types: Statewide, Air Basin, Air District, MPO, County, or 
Sub-Area. Please refer to Appendix 3 for area definitions. 
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• The user may pick only one Area Type, but has the option of selecting multiple 
Areas within the chosen Area Type by holding the Ctrl key while clicking on an 
area. 
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• “Air Basin” has been selected in the following window, so multiple selections can 
be made (see figure). 

23 



 
 

 
 

   

      
    

 

 

  

EMFAC2021 User’s Guide 

TIME TAB 

• In the “Time” tab, a single Calendar Year or multiple years may be selected; 
however, only one Season or Month may be selected for each run. 
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VEHICLES TAB 

• In the Vehicle Class list box, the user can select the vehicle classes of interest. 
All vehicles can be selected by clicking “Select All”. EMFAC202x, EMFAC2011 
and EMFAC2007 Vehicle Classes are all available. Note that “EMFAC202X 
Vehicle Class” is newly added in this version of EMFAC. Please refer to 
Appendix 4 for definitions of vehicle categories. 

• The data can be output in either “By Model Year” or “Aggregated” form.  
o Choosing “By Model Year” and selecting a large number of Model Years will 

increase the size of the output considerably. 
• The user can choose to output the data “By Speed” (for output at each speed) or 

“Aggregated” (for combined output only). 
o Choosing “By Speed” will increase the size of the Output Table considerably. 
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OUTPUT TAB 

• The “Pollutants” group box allows the user to choose the Pollutants to be 
included in the output. One new option in the “Pollutants” group box in 
EMFAC2021 is “NH3”. 

• The “Activities” group box indicates which Activity data can be selected to be 
included in the output. One new option in the “Activities” group box in 
EMFAC2021 is “Energy Consumption”.  Once it is selected, the model will 
generate electricity consumption in the output. 

• The “Options” group box allows the user to choose “Output by Process” to 
output data per emissions process (e.g., Running Exhaust Emissions, or Start 
Exhaust Tailpipe emissions) or to choose “Output by Cat-NonCat” for output per 
catalyst-equipped and non-catalyst equipped groupings. 

• The “Save Data” group box selection will indicate whether the output data from 
the current run will be saved by the model INTERNALLY for reuse by eligible 
future runs. This does not affect model outputs. 

• The “Output Options” group box allows users to: 1) split the model output into 
separate files based upon Sub-Area and Calendar Year to keep the size of the 
output files manageable; 2) specify a different directory to hold the output files 
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other than the default directory at “C:\emfac2021\Output” by clicking the 
“Change Directory” button. 

• The standard output format for a Default run is “CSV” (comma-separated text 
files).  The output files will have a numerical timestamp in the name of the files. 

STARTING THE MODEL RUN 

• Limiting the number of calendar years, areas, and the level of detail selected will 
reduce the free space required for a run. This requirement decreases 
considerably if you deselect some of the options such as “By Hour”, “By Model 
Year”, etc. 

• Click “Run EMFAC”, in the Run Menu, or the “Run” button at the lower right 
corner of the Output tab to start the model run. 

SAVING THE RUN SPECIFICATION 

• Save the “Run Specification” (as “.ers” files) for future use after all the run 
parameters have been determined. Click “Save” in the file menu or click “OK” in 
the pop-up window after the run button is clicked to save the .ers file. 
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ONCE THE RUN HAS STARTED 

• The time it takes to finish a run depends on how many sub-areas and calendar 
years were selected, the aggregation level specified for the output files, and the 
performance of the computer. 

• The model run can be stopped by clicking “Cancel” in the EMFAC2021 Window. 

• Once the model run is done, the following window provides the names and 
locations of the output files generated after the run has finished. 
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• A default emissions run file name will consist of the sub-area, the analysis year, 
the season, data type (emission, GHG, VMT, energy consumption, vehicle 
population, and trips), and the time when the output file was generated. The 
user has the option to modify the first half of the filenames to their own naming 
standards when saving the run specification. However, the data type and output 
file generation time will still be indicated at the end of filename. 
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STARTING DEFAULT RUN USING A SAVED .ERS FILE 

1. Click “Open” in the File Menu to load the file. 

2. The run parameters will be loaded to the model and can be modified and 
saved as a new .ers file by clicking “Save” in the File Menu. 

5.2 USING CUSTOM ACTIVITY MODE (SG) 

BACKGROUND 

The Custom Activity (SG) Mode of EMFAC2021 is designed to perform emissions 
assessments for determining conformity with the state implementation plan and for 
compliance with SB375 targets.  Both types of assessments are most often done by 
various planning agencies and air districts throughout California. These assessments 
require the user to create custom activity data files containing vehicle miles travelled 
(VMT) and/or speed profile data. This customized activity data will then be used for 
scaling the default vehicle emissions produced by EMFAC2021.  

In addition, EMFAC2021 has extended the functionality of the SG mode.  It allows users 
to develop emission scenarios by varying not only the total VMT and VMT distribution 
by speed, but also changing the technology mix of different fuel types (e.g., natural gas, 
electric, and diesel). The SG mode of EMFAC2021 outputs all the available fuel types 
in the model, including gasoline, PHEV, diesel, natural gas, and electric. 

SAVING OUTPUT DATA FROM A RUN FOR FUTURE USE 

As a way to reduce computational time, the model allows the output data from the 
current run to be saved for future use if “Save data from this run for future use” is 
selected in the Output tab. This works for both Default Activity Runs as well as Custom 
Activity (SG) runs. 

Data saved from previous runs can be used if one or more of the three criteria are met: 
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1. The current run has exactly the same run parameters as one of the previous 
runs that have output saved. 

2. The run parameters (Calendar Years, Areas) of the current run are a subset of 
parameters of one of the previous runs that have output saved. 

3. The current run has fewer details or is more aggregated than the previous runs 
with saved output. 

Model run time is significantly reduced when the saved output from previous runs option 
is used for the current run. Extracting data already stored in the model database is 
much faster than recalculating it. 

TYPES OF CUSTOM ACTIVITY DATA 

There are two custom activity input formats supported by EMFAC2021 known as 
standard format: 

• templates generated by EMFAC2017 
• templates generated by EMFAC2021 

For all types of SG templates, the names of the worksheets MUST be exactly the same 
as produced from either EMFAC2017 or EMFAC2021.  EMFAC2021 uses these 
worksheet names to identify what type of data is present and worksheets with any other 
names will be ignored. The user must provide either daily total VMT or daily total VMT 
by vehicle-tech.  Speed fraction profiles are optional. 

EMFAC2021 can import multiple sets of activity data at one time. Also, EMFAC2021 
can only process data for multiple scenarios with the same type of area and season.  
Files with different area types or seasons or SB375 settings cannot be loaded together. 
That is, one cannot run a scenario with the SCAG MPO and the Lake Tahoe Air Basin, 
since the first is an MPO and the second is an Air Basin. Also files with same 
area/calendar year combinations will be over-written. For example, loading two different 
template files for Alameda/CY2030 with different VMTs at the same time will only 
generate one emissions output (VMT data from the latter file will be used for emissions 
calculations) 

Generally speaking, EMFAC2021 SG mode template generation is the same as 
EMFAC2017.  It will produce a template with the default VMT and the optional hourly 
speed fraction profile data. The EMFAC2021 custom activity data template is always 
saved in the Excel format and the suffix is “*.xlsx”. The table below summarizes the 
worksheets contained in the EMFAC2021-formatted Excel activity template file. 
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Worksheets in EMFAC2021 Format Activity Templates 
Template File
Format Type Worksheet Name Description of Worksheet Data Fields 

Settings Season/month and whether it is a SB375 template 
EMFAC2021 

And 
EMFAC2017 

(*.xlsx) 

daily_total_vmt** Daily total VMT 
daily_vmt_by_veh_tech** Daily VMT by vehicle type and fuel 

hourly_fraction_veh_tech_speed* Hourly speed profile calculated using default VMT 
by hour by speed 

*Optional – may or may not be created based on user input; 
**One, not both, will exist. 

The “settings” worksheet is used for two purposes: to specify the season/month value 
for the desired emissions run, and to indicate whether the template is for SB375 or 
conformity purposes. 

The table below summarizes the effect of selected GUI options in EMFAC2021 on 
which worksheets are generated (see ** in the table above) and how custom activity 
scaling is performed. 

EMFAC2021 Templates: Effect of GUI Options on Worksheets and Scaling 
User Select GUI Options Scaling Approach 

(Cannot be Modified) 

VMT Data Type 
Custom 

Hourly Speed 
Fractions 

VMT Scaling Result Speed Scaling? 

Total Daily VMT Unchecked Scaling by VMT Total No 
VMT by Vehicle and 

Fuel Type Unchecked Scaling by VMT-Veh Tech No 

Total Daily VMT Checked Scaling by VMT Total Yes 
VMT by Vehicle and 

Fuel Type Checked Scaling by VMT-Veh Tech Yes 

IMPORTANT! If the user opts to generate an SB375 template (more details are 
provided in the next section), the Excel template will be ‘hard coded’ as an SB375 
template. This is because SB375 runs require the Pavley and Advanced Clean Cars 
standards to be turned off in the calculations made for the emissions inventory that will 
be generated. The Advanced Clean Cars program assumes a different fleet mix and 
vehicle miles travelled, so output produced for SB375 purposes will not match output 
that was not produced for SB375 purposes. 
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GENERATING A CUSTOM ACTIVITY TEMPLATE 

The run parameters for generating a custom activity template are summarized in 
Appendix 5. 

1. Select the “Custom Activity (SG)” Run Type, and then “Generate Custom 
Activity Template” in the pop-up dialog box that appears. 
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2. Click “Start”.  The following window will appear: 

3. In the Area tab, you can change the area type by clicking where “Sub-Area” 
appears above. 

4. Select one or more Areas. If you hold down either the shift or the control key 
while clicking, you can select multiple areas. Please note that the more areas 
selected, the longer the runtime will be. 

5. Click “Next” or the Time tab. 
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6. On the Time tab, select one or more calendar years, however, the more years 
you select, the longer runtime will be. 

7. Select “Season” or “Month” and then specify which Season or Month you 
would like to use. 

8. Click “Next” or the VMT tab. 
9. On the VMT tab, select the VMT data type you would like for inputting the data 

into the template you will generate. 
10. Select “Custom Hourly Speed Fractions” if your own speed profile will be used. 
11. Choose whether or not the template will be for SB375. 
12. Click the “Generate Template” button. 
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13. Select where the template will be saved, then click “Save” and the model will 
start generating the template. 
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14. Click “Save” and the model will start generating the template. 

15.The following window will be shown after the template is generated. 
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MODIFYING CUSTOM ACTIVITY TEMPLATES 

Custom activity templates are generated in a Microsoft Excel format.  Users can use 
Excel to edit the data to meet their needs. Before using the activity templates, there are 
several things to know: 

• Standard custom activity templates are in Microsoft Excel worksheet (.xlsx) 
format. 

• The worksheet names for either of these types of custom activity template must 
not be changed. These names are used to identify what type of data is present. 
Worksheets with any other names will be ignored. 

• The order and names of columns should not be changed on worksheets and 
data rows should not be deleted. 

• Standard custom activity Templates have a worksheet named “Settings” 
(below). This is primarily used to define the season or month being analyzed 
and whether the custom activity template contains activity for a conformity 
assessment or an SB375 assessment. The field indicating the season/month 
can be changed; the field with the SB375 setting cannot be changed. 
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• For worksheets broken out by vehicle-tech, all vehicle-tech types must be 
present. If you generate a standard custom activity template, all necessary 
combinations of vehicle-tech’s should be provided. 

• If “Custom Hourly Speed Fractions” is selected, the speed fractions should add 
up to one for each hour in the “Hourly_Fraction_Veh_Tech_Speed” tab. 

• The EMFAC default speed profile will always be used for the following vehicle 
types with all fuel types for all regions: 
• PTO 
• UBUS 
• SWCV 

• The EMFAC default speed profile will always be used for drayage trucks with all 
fuel types for Alameda (SF), Los Angeles (MD), Los Angeles (SC), San 
Bernardino (MD), and San Bernardino (SC): 
• T7 Other Port 
• T7 POAK 
• T7 POLA 
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RUNNING EMFAC WITH A CUSTOM ACTIVITY TEMPLATE 

The run parameters for generating a customized activity inventory are summarized in 
Appendix 6. 

1. Return to the Home Screen by selecting “File”, “New” from the menu and 
select “Custom Activity (SG)”. 

2. Select “Load Custom Activity File” and click the “Start” button. 
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3. Click the “Load Custom Activity” button and find the file. You can hold down 
either the shift or control keys during selection to load more than one file at a 
time. 

* IMPORTANT * 

Files with different area types or seasons or SB375 settings cannot 
be loaded together. Also files with same area/calendar year 
combinations will be over-written. For example, loading two 
different template files for Alameda/CY2030 with different VMTs at 
the same time will only generate one emissions output (VMT data 
from the latter file will be used for emissions calculations) 

4. Select the desired file and then click “Open”. Click “Ok”. 
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5. Information about the loaded file is displayed on the window.  Make sure the 
correct file has been selected. 

6. In the output tab, pick the Report Type, choose whether or not to save the 
output data for future use, and change the output location if desired. (See 
Chapter 7 for a description of the Output Files generated by EMFAC2021). 
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7. If the SB375 file was loaded, the output tab will be like the following screen 
shot. 
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8. Click “Run” to start the calculation. 
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9. After the run completes, a window will show the Output File location and file 
name. 
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6 GENERATING EMISSIONS RATES 

This section describes how to run EMFAC for a Project-Level (PL) Assessment to 
generate emission rates using project-specific data. This mode generates emission 
rates based on meteorological input (temperature and relative humidity) that users 
provide. 

6.1 SETTING UP A PROJECT-LEVEL ASSESSMENT EMISSIONS RATES 
RUN 

The run parameters for generating emissions rates are summarized in Appendix 7. 

1. Start the model or clicking “New” in the File menu. 
2. Select Emission Rates as the Run Mode, and Project-Level Assessment (PL) 

as the Run Type and click “Start”. 
• This takes the user to a window with four tabs; the Area Tab, the Time Tab, 

the Vehicles Tab, the Meteorology Tab, and the Output Tab. Each tab 
presents options for the user to customize the PL run. 
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AREA TAB 

• Pick one Area Type and select one or more areas of the chosen Area Types. 
Hold down the Shift key and click areas to select multiple areas. 
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TIME TAB 

• In the “Time” tab, a single Calendar Year or multiple years may be selected; 
however, only one Season or Month may be selected for each run. 

• Emissions rates vary by season or month as a result of variation in the fuel Reid 
Vapor Pressures (RVP) by month or season due to fuel composition differences. 

49 



 
 

 
 

  

      

  
  

 
     

  
       

     
  

  
    

 

EMFAC2021 User’s Guide 

VEHICLES TAB 

• The user can select the vehicle classes of interest. All vehicles can be selected 
by clicking “select all.”  Emissions rates can also be provided at various sub-
levels using the EMFAC202x, EMFAC2011 or EMFAC2007 vehicle classes and 
selections such as truck/non-truck, or truck1/truck2/non-truck levels.  Please 
refer to the definitions of vehicle categories in Appendix 4. 

• The data can be output in either the “By Model Year” or the “Aggregated” 
format.  
o The “By Model Year” option is for projects in which the activity data by 

model year are used. 
o The “Aggregated” option is for projects in which only the aggregated total 

activity, but not the activity by model year, is used. 
• The user can choose to output the data “By Fuel” (for output by each fuel type) 

or “Aggregated” (for aggregated output only). 
• In a PL Run, speed bins must be selected. 
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METEOROLOGY TAB 

• PL Runs require users to meteorological conditions 
• Each pair of temperature (in Fahrenheit) and relative humidity (in percentage 

without % sign) must be provided in each row.  See the example in the following 
screen shot. 
o The number of pairs of temperature and relative humidity will be limited to 

24 for each PL run; that is one pair for each hour of the day 
o The user may either type the temperatures and relative humidity pairs into 

the meteorology box or copy the data from an Excel File. 
• The allowed input temperature range is from -20°F to 120°F and the allowed 

input relative humidity range is from 0% to 100%. 
o These input ranges are broader than the corresponding default ranges, 

used in EMFAC2021. The default ranges are 16.7°F to 106.9°F and 13% 
to 100%, and these are based upon real meteorology data 
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OUTPUT TAB 

• The Pollutants group box allows the user to choose the Pollutants for which data 
are to be included in the output. 

IMPORTANT – CO2 emission rates from PL tool are tailpipe CO2 and are not 
the same as the “complete combustion CO2” under the “emission” mode. 

• The Output Options group box allows users to specify a different directory to 
hold the output files by clicking the “Change Directory” button. 
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6.2 STARTING THE PROJECT LEVEL MODEL RUN 
• Click “Run EMFAC”, in the Run Menu, or the “Run” button at the lower right 

corner of the Output tab to start the model run. 
• Save the “Run Specification” (as .ers file) for future use after all run parameters 

have been determined.  Click “Save” in the File menu or click “OK” in the pop-up 
window after the run button is clicked to save the .ers file. 

• The model run can be stopped by clicking “Cancel” in the EMFAC2021 Window. 
• The pop-up window provides the names and locations of the output files 

generated after the run has finished. 
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7 DESCRIPTION OF OUTPUT 

By default, the output files are saved in the “output” folder under the EMFAC installation 
directory. Users can specify another folder to hold these files. Output file names, which 
are generated automatically, start with the name of .ers files or the names of the custom 
activity input files, followed by output type and a timestamp suffix. 

For example, the default names for the output files for the default activity emissions run 
specification file “Default_AlamedaSF_2012_Annual.ers” will be: 

• “Default_AlamedaSF_2012_Annual_emission_20201208193758.csv” for the 
emissions inventory file; 

• “Default_AlamedaSF_2012_Annual_ghg_20201208193758.csv” for the ghg 
emissions inventory file; 

• “Default_AlamedaSF_2012_Annual_population_20201208193758.csv” for the 
vehicle population file; 

• “Default_AlamedaSF_2012_Annual_trips_20201208193758.csv” for the trips 
file; 

• “Default_AlamedaSF_2012_Annual_vmt_20201208193758.csv” for the vehicle 
miles traveled file. 

• “Default_AlamedaSF_2012_Annual_energycons_20201208193758.csv” for the 
energy consumption file. 

The default names for the output files for the custom activity emissions input file 
“Custom_KernSJV_2020_Annual.xlsx” will be: 

• “Custom_KernSJV_2020_Annual_ emission_20201208231949.csv” for the 
emissions inventory file; 

• “Custom_KernSJV_2020_Annual_ population_20201208231949.csv” for the 
vehicle population file; 

• “Custom_KernSJV_2020_Annual_ trips_20201208231949.csv” for the tips file; 
• “Custom_KernSJV_2020_Annual_ vmt_20201208231949.csv” for the vehicle 

miles traveled file; 
• “Custom_KernSJV_2020_Annual_planning_20201208231949.xlsx” for the 

planning inventory file; 
• “Custom_KernSJV_2020_Annual_ctf_20201208231949.csv” for the CEIDARS 

Transaction Format (CTF) file. 

The default names for the output files for the run specification file for the emission rates 
input file “PL_AlamedaSF_2012_Annual.ers” will be: 

• “PL_AlamedaSF_2012_Annual_2020120812621.csv” for the emissions rate file 
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7.1 CSV (COMMA SEPARATED VALUES) 

The standard output format from EMFAC2021 is CSV (comma-separated values), the 
same as previous versions of EMFAC. CSV is a common, relatively simple file format 
that is widely used by consumers, businesses, and scientific applications. 

For emissions runs, both EMFAC default and custom activity type, the model may 
output up to four CSV files per Sub-Area and Calendar Year. Typically, emissions data, 
VMT, energy consumption, trips, and vehicle population data are reported in separate 
output files. 

Please note that the speed_time column in the emissions rates report from a PL run 
contains different values for different processes.  It indicates speed bin for running 
exhaust and it indicates the time, in minutes, that the vehicle has been sitting prior to 
starting for start emissions. 

Table 7-1 provides descriptions of the columns in the emissions, activity, and emission 
rates CSV output files. Table 7-2 lists the emissions processes in the emissions rates 
output files. 

As stated in Section 4.1, in order to manage the size of the output files, emissions and 
emission rates that are equal to zero are not included in the output files.  Therefore, in 
instances when data are missing in the output file, the user can interpret them as zero 
emissions or an emission rate of zero. 
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Table 7-1: Summary of Columns in CSV output Files 

Column Name Description 
calendar_year Calendar Year between 2000 -2050 
season_month Annual, summer, winter or one of the twelve months 
sub_area (GAI) Sub Area as defined in Appendix 3 
vehicle_class Vehicle class as defined in Appendix 4 
fuel Gasoline, PHEV, diesel, natural gas, and electric 
model_year Model year 
hour One of the 24 hour 
speed Speed bin from 5 to 90 with 5 incremental 
process Emission process 
cat_ncat With or without catalytic converter 
pollutant Pollutants 
emission Amount of emissions 
vmt Vehicle-miles traveled 
trips Number of trips 
population Vehicle population 
temperature Temperature in Fahrenheit 
relative_humidity Relative humidity in percentage 

speed_time 

For running exhaust (RUNEX), the “speed_time” column 
provides the speed bin ranging from 5 mph to 90 mph. For 
the start process, this field provides the soak time prior to 
vehicle starting in minutes, ranging from 5 minutes to 720 
minutes. For other processes, where emissions rates do not 
depend on speed bin or soak time, this field is blank. 

emission_rate Emissions per unit of activity 

Table 7-2: Emissions Processes in Emissions Rates Files 

Emission Process Description 
RUNEX Running Exhaust 
IDLEX Idle Exhaust 
STREX Start Exhaust 
RUNLOSS Running Loss Evaporative 
HOTSOAK Hot Soak Evaporative 
DIURN Diurnal Evaporative 
PMTW PM Tirewear 
PMBW PM Brakewear 
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7.2 PLANNING INVENTORY REPORT 

The Planning Inventory Report generated from the Custom Activity type is a Microsoft 
Excel Workbook that contains emissions and activities which are summed by area, 
calendar year, and vehicle-tech type. It provides a column for every pollutant and 
process, with sub-total columns at the appropriate places.  It provides a summary 
worksheet for a given area and another worksheet entitled “By Sub-Area” in which the 
data are broken out by the sub-areas within the area specified by the user (if selected).  
If a run is only for a single sub-area, or if an area only has one sub-area (such as the 
Lake County Air Basin), only one data worksheet will be produced. This report includes 
a “Read_me” tab and a “Glossary tab” which provides information on the report type, 
the date and time the report was generated, and an explanation of the columns. 

IMPORTANT! The Planning Inventory Report generated from the Custom Activity type 
does not correspond to official GHG emissions. However, the EMFAC2021 default runs 
employ a methodology consistent with CARB’s official GHG inventory estimation. 

7.3 SB375 REPORT 

The SB375 report generated from the Custom Activity type is a Microsoft Excel 
Workbook that is a sub-set of the Planning Inventory Report described above.  It is 
limited to four light-duty vehicle types (LDA, LDT1, LDT2, and MDV), CO2 emissions, 
and related activity. The only vehicle-tech types included in this SB375 report are: 

• LDA - DSL 
• LDA - ELEC 
• LDA - GAS 
• LDA - PHE 
• LDT1 - DSL 
• LDT1 - ELEC 
• LDT1 - GAS 
• LDT1 - PHE 
• LDT2 - DSL 
• LDT2 - ELEC 
• LDT2 - GAS 
• LDT2 - PHE 
• MDV - DSL 
• MDV - ELEC 
• MDV - GAS 
• MDV - PHE 
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IMPORTANT! – Note again that, for SB375 analyses, ACC/Pavley are deactivated. 
Also, because the ACC regulation has certain assumptions about vehicle usage built 
into it, default data in custom activity templates produced for conformity assessments 
will not match the default data in templates for SB375 assessments (differences will 
result and affect any comparisons between the two).  As a result, CO2 emissions in an 
SB375 report will not equal CO2 emissions from a standard planning inventory report. 

7.4 CTF REPORT 

The CEIDARS Transaction Format (CTF) generated from the Custom Activity type is a 
report used internally by CARB to import emissions inventory data into an internal 
emissions inventory database and forecasting system. The area and sub-area fields, 
produced by EMFAC, are replaced with the County-Air Basin-District coding system, 
and the Emissions Inventory Code (EIC) system replaces the vehicle-tech type and the 
processes. Appendix 8 describes the fields in a CTF file. 
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APPENDIX 1 DISK SPACE REQUIREMENTS FOR RUNNING EMFAC2021 

The disk space needed to perform EMFAC2021 runs consists of two parts: the disk space needed to run the model, e.g. . 
to perform database operations (on the system drive); and the disk space needed on the user specified drive for saving 
output files. Both vary significantly based on the specifications of the run. If the output drive is the same as the system 
drive, the two parts will need to be added up. This appendix provides estimates for some typical runs that can be used to 
help estimate the space needed for a particular run. 

• Default Runs 
o The disk space needed for database operations for default runs can be up to about 3 GB if “By Speed” is 

selected; 
o If speed is not selected, it usually should not take more than 1 GB; 
o The disk space estimates for the output files for ONE sub-area, ONE calendar year, ALL vehicle classes, ALL 

pollutants, ALL activities (size may vary slightly by sub-area and calendar year): 

Vehicle Class Type By Hour By Speed By Model Year By Fuel By Process Output Size 

202x No No No No No 0.09 MB 

202x No No No Yes Yes 0.23 MB 

202x Yes No No Yes Yes 3.8 MB 

202x Yes Yes No Yes Yes 26.3 MB 

202x Yes Yes Yes (All) Yes Yes 816 MB 

2011 Yes Yes Yes (All) Yes Yes 533 MB 

2007 Yes Yes Yes (All) Yes Yes 912 MB 
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• SG Runs: 
o The disk space needed for database operations for SG runs can be up to about 3GB if 

“Hourly_Fraction_Veh_Tech_Speed” is included in the template; 
o If “Hourly_Fraction_Veh_Tech_Speed” is not included, it should not take more than 1GB; 
o The disk space estimates for ONE sub-area and ONE calendar year for EMFAC2021 input templates: 

SG Run with EMFAC2021 
Custom 

Activity File 

Custom 
Speed

Fraction 

CSV 
Template 

Size 
CSV 

Output Size 

Planning 
Inventory 

Output Size 
CTF 

Output Size 
SB375 

Output Size 

Total daily VMT 

Yes 0.24MB 36.97MB 

No 0.007MB 0.25MB 

0.05 M 0.24 M 0.009MB 

Yes 0.24MB 36.97MB 
VMT by vehicle and fuel 

type 
No 0.009MB 0.25MB 
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APPENDIX 2 SUMMARY OF RUN PARAMETERS FOR GENERATING DEFAULT EMISSIONS 
INVENTORY 

Tab Run Parameters Description 

Area 
Area Type One of the area types can be picked. 

Area One or more areas can be selected for one run. 

Time 

Calendar Year Between 2000 and 2050. One or more calendar years can be selected for one run. 

Season/Month One of the three seasons (annual, summer, winter) or one of the 12 months can be selected for one run. 

Day or Hour 
Aggregation Output emissions by day or by hour. 

Vehicle 
s 

Vehicle Class type Output by EMFAC202x, EMFAC2011, or EMFAC2007 vehicle class. 

Vehicle Class One or more vehicle classes can be picked for one run. 

Model Year Aggregated or by model year in output.  One or more model years can be selected if by model year is 
picked. 

Speed Aggregated or by speed in output. 

Output 

Pollutants Pollutants in output. 

Activities Pick one or more of the activities (VMT, vehicle population, trips, or energy consumption) to be included in 
output files. 

Output by process Whether to output by process. 

Output by Cat/NonCat Whether to output by Cat/NonCat. 

Save data for future 
use Users can get results faster in the future if data from previous runs are saved and used. 

Output Options 
Whether to split output by Sub Area & Calendar Year 

Where to save output files. 
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APPENDIX 3 DEFINITION OF AREAS 
Sub-Area 

Alameda (SF) 

Alpine (GBV) 

County Name 

ALAMEDA 

ALPINE 

Air Basin Name 
SAN FRANCISCO BAY 
AREA 
GREAT BASIN VALLEYS 

Air District Name 

BAY AREA AQMD 

GREAT BASIN UNIFIED APCD 

MPO 

MTC 

MPO Name 

Metropolitan Transportation Commission 

Amador (MC) AMADOR MOUNTAIN COUNTIES AMADOR COUNTY APCD 

Butte (SV) BUTTE SACRAMENTO VALLEY BUTTE COUNTY AQMD BCAG Butte County Association of Governments 

Calaveras (MC) CALAVERAS MOUNTAIN COUNTIES CALAVERAS COUNTY APCD 

Colusa (SV) 

Contra Costa (SF) 

Del Norte (NC) 

COLUSA 

CONTRA COSTA 

DEL NORTE 

SACRAMENTO VALLEY 
SAN FRANCISCO BAY 
AREA 
NORTH COAST 

COLUSA COUNTY APCD 

BAY AREA AQMD 

NORTH COAST UNIFIED AQMD 

MTC Metropolitan Transportation Commission 

El Dorado (LT) 
El Dorado (MC) 

Fresno (SJV) 

Glenn (SV) 

EL DORADO 
EL DORADO 

FRESNO 

GLENN 

LAKE TAHOE 
MOUNTAIN COUNTIES 

SAN JOAQUIN VALLEY 

SACRAMENTO VALLEY 

EL DORADO COUNTY APCD 
EL DORADO COUNTY APCD 
SAN JOAQUIN VALLEY UNIFIED 
APCD 
GLENN COUNTY APCD 

TMPO 
SACOG 

COFCG 

Tahoe Metropolitan Planning Organization 
Sacramento Area Council of Governments 

Fresno Council of Governments 

Humboldt (NC) 

Imperial (SS) 

Inyo (GBV) 

HUMBOLDT 

IMPERIAL 

INYO 

NORTH COAST 

SALTON SEA 

GREAT BASIN VALLEYS 

NORTH COAST UNIFIED AQMD 

IMPERIAL COUNTY APCD 

GREAT BASIN UNIFIED APCD 

SCAG Southern California Association of 
Governments 

Kern (MD) 

Kern (SJV) 

Kings (SJV) 

Lake (LC) 

KERN 

KERN 

KINGS 

LAKE 

MOJAVE DESERT 

SAN JOAQUIN VALLEY 

SAN JOAQUIN VALLEY 

LAKE COUNTY 

KERN COUNTY APCD 
SAN JOAQUIN VALLEY UNIFIED 
APCD 
SAN JOAQUIN VALLEY UNIFIED 
APCD 
LAKE COUNTY AQMD 

KCOG 

KCOG 

KCAG 

Kern Council of Governments 

Kern Council of Governments 

Kings County Association of Governments 

Lassen (NEP) 

Los Angeles (MD) 

Los Angeles (SC) 

Madera (SJV) 

Marin (SF) 

LASSEN 

LOS ANGELES 

LOS ANGELES 

MADERA 

MARIN 

NORTHEAST PLATEAU 

MOJAVE DESERT 

SOUTH COAST 

SAN JOAQUIN VALLEY 

SAN FRANCISCO BAY 
AREA 

LASSEN COUNTY APCD 

ANTELOPE VALLEY AQMD 

SOUTH COAST AQMD 

SAN JOAQUIN VALLEY UNIFIED 
APCD 

BAY AREA AQMD 

SCAG 

SCAG 

MCTC 

MTC 

Southern California Association of 
Governments 
Southern California Association of 
Governments 

Madera County Transportation Commission 

Metropolitan Transportation Commission 
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Sub-Area County Name Air Basin Name Air District Name MPO MPO Name 

Mariposa (MC) MARIPOSA MOUNTAIN COUNTIES MARIPOSA COUNTY APCD 

Mendocino (NC) 

Merced (SJV) 

MENDOCINO 

MERCED 

NORTH COAST 

SAN JOAQUIN VALLEY 

MENDOCINO COUNTY AQMD 
SAN JOAQUIN VALLEY UNIFIED 
APCD MCAG Merced County  Association of Governments 

Modoc (NEP) MODOC NORTHEAST PLATEAU MODOC COUNTY APCD 

Mono (GBV) MONO GREAT BASIN VALLEYS GREAT BASIN UNIFIED APCD 

Monterey (NCC) 

Napa (SF) 

MONTEREY 

NAPA 

NORTH CENTRAL COAST 
SAN FRANCISCO BAY 
AREA 

MONTEREY BAY UNIFIED APCD 

BAY AREA AQMD 

AMBAG 

MTC 

Association of Monterey Bay Governments 

Metropolitan Transportation Commission 

Nevada (MC) 

Orange (SC) 

NEVADA 

ORANGE 

MOUNTAIN COUNTIES 

SOUTH COAST 

NORTHERN SIERRA AQMD 

SOUTH COAST AQMD SCAG Southern California Association of 
Governments 

Placer (LT) PLACER LAKE TAHOE PLACER COUNTY APCD TMPO Tahoe Metropolitan Planning Organization 

Placer (MC) PLACER MOUNTAIN COUNTIES PLACER COUNTY APCD SACOG Sacramento Area Council of Governments 

Placer (SV) PLACER SACRAMENTO VALLEY PLACER COUNTY APCD SACOG Sacramento Area Council of Governments 

Plumas (MC) 
Riverside 
(MD/MDAQMD) 
Riverside 
(MD/SCAQMD) 

Riverside (SC) 

Riverside (SS) 

Sacramento (SV) 

PLUMAS 

RIVERSIDE 

RIVERSIDE 

RIVERSIDE 

RIVERSIDE 

SACRAMENTO 

MOUNTAIN COUNTIES 

MOJAVE DESERT 

MOJAVE DESERT 

SOUTH COAST 

SALTON SEA 

SACRAMENTO VALLEY 

NORTHERN SIERRA AQMD 

MOJAVE DESERT AQMD 

SOUTH COAST AQMD 

SOUTH COAST AQMD 

SOUTH COAST AQMD 

SACRAMENTO METROPOLITAN 
AQMD 

SCAG 

SCAG 

SCAG 

SCAG 

SACOG 

Southern California Association of 
Governments 
Southern California Association of 
Governments 
Southern California Association of 
Governments 
Southern California Association of 
Governments 

Sacramento Area Council of Governments 

San Benito (NCC) 

San Bernardino (MD) 

San Bernardino (SC) 

San Diego (SD) 

San Francisco (SF) 

San Joaquin (SJV) 

SAN BENITO 
SAN 
BERNARDINO 
SAN 
BERNARDINO 

SAN DIEGO 

SAN FRANCISCO 

SAN JOAQUIN 

NORTH CENTRAL COAST 

MOJAVE DESERT 

SOUTH COAST 

SAN DIEGO 

SAN FRANCISCO BAY 
AREA 

SAN JOAQUIN VALLEY 

MONTEREY BAY UNIFIED APCD 

MOJAVE DESERT AQMD 

SOUTH COAST AQMD 

SAN DIEGO COUNTY APCD 

BAY AREA AQMD 

SAN JOAQUIN VALLEY UNIFIED 
APCD 

AMBAG 

SCAG 

SCAG 

SANDA 
G 

MTC 

SJCOG 

Association of Monterey Bay Governments 
Southern California Association of 
Governments 
Southern California Association of 
Governments 

San Diego Association of Governments 

Metropolitan Transportation Commission 

San Joaquin Council of Governments 
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Sub-Area 

San Luis Obispo (SCC) 

San Mateo (SF) 

Santa Barbara (SCC) 

Santa Clara (SF) 

County Name 
SAN LUIS 
OBISPO 

SAN MATEO 

SANTA 
BARBARA 

SANTA CLARA 

Air Basin Name 

SOUTH CENTRAL COAST 

SAN FRANCISCO BAY 
AREA 

SOUTH CENTRAL COAST 

SAN FRANCISCO BAY 
AREA 

Air District Name 

SAN LUIS OBISPO COUNTY APCD 

BAY AREA AQMD 

SANTA BARBARA COUNTY APCD 

BAY AREA AQMD 

MPO 
SLOCO 
G 

MTC 

SBCAG 

MTC 

MPO Name 

San Luis Obispo Council of Governments 

Metropolitan Transportation Commission 

Santa Barbara County Association of 
Governments 

Metropolitan Transportation Commission 

Santa Cruz (NCC) 

Shasta (SV) 

SANTA CRUZ 

SHASTA 

NORTH CENTRAL COAST 

SACRAMENTO VALLEY 

MONTEREY BAY UNIFIED APCD 

SHASTA COUNTY AQMD 

AMBAG 
SCRTP 
A 

Association of Monterey Bay Governments 

Shasta Regional Transportation Agency 

Sierra (MC) SIERRA MOUNTAIN COUNTIES NORTHERN SIERRA AQMD 

Siskiyou (NEP) 

Solano (SF) 

SISKIYOU 

SOLANO 

NORTHEAST PLATEAU 
SAN FRANCISCO BAY 
AREA 

SISKIYOU COUNTY APCD 

BAY AREA AQMD MTC Metropolitan Transportation Commission 

Solano (SV) 

Sonoma (NC) 

Sonoma (SF) 

Stanislaus (SJV) 

SOLANO 

SONOMA 

SONOMA 

STANISLAUS 

SACRAMENTO VALLEY 

NORTH COAST 

SAN FRANCISCO BAY 
AREA 

SAN JOAQUIN VALLEY 

YOLO/SOLANO AQMD 
NORTHERN SONOMA COUNTY 
APCD 

BAY AREA AQMD 

SAN JOAQUIN VALLEY UNIFIED 
APCD 

MTC 

MTC 

MTC 

StanCO 
G 

Metropolitan Transportation Commission 

Metropolitan Transportation Commission 

Metropolitan Transportation Commission 

Stanislaus Council of Governments 

Sutter (SV) SUTTER SACRAMENTO VALLEY FEATHER RIVER AQMD SACOG Sacramento Area Council of Governments 

Tehama (SV) TEHAMA SACRAMENTO VALLEY TEHAMA COUNTY APCD 

Trinity (NC) 

Tulare (SJV) 

TRINITY 

TULARE 

NORTH COAST 

SAN JOAQUIN VALLEY 

NORTH COAST UNIFIED AQMD 
SAN JOAQUIN VALLEY UNIFIED 
APCD TCAG Tulare County Association of Governments 

Tuolumne (MC) 

Ventura (SCC) 

TUOLUMNE 

VENTURA 

MOUNTAIN COUNTIES 

SOUTH CENTRAL COAST 

TUOLUMNE COUNTY APCD 

VENTURA COUNTY APCD SCAG Southern California Association of 
Governments 

Yolo (SV) YOLO SACRAMENTO VALLEY YOLO/SOLANO AQMD SACOG Sacramento Area Council of Governments 

Yuba (SV) YUBA SACRAMENTO VALLEY FEATHER RIVER AQMD SACOG Sacramento Area Council of Governments 
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APPENDIX 4 VEHICLE CATEGORIES 

EMFAC202x 
veh & fuel 

EMFAC202x 
Vehicle 
Class 

Description 
EMFAC2011 

Vehicle 
Class*** 

EMFAC2007 
Vehicle 
Class 

EMFAC2007 
Vehicle 
Code 

Truck /
Non-
Truck 

Category 

Truck 
1 /

Truck 
2 

/Non-
Truck 

LDA - Dsl 
LDA - Gas 
LDA - Elec 
LDA - Phe 

LDA Passenger Cars LDA LDA LDA Non-
Truck 

Non-
Truck 

LDT1 - Dsl 
LDT1- Gas 
LDT1 - Elec 
LDT1 - Phe 

LDT1 Light-Duty Trucks (GVWR* <6000 lbs 
and ETW** <= 3750 lbs) LDT1 LDT1 T1 Non-

Truck 
Non-
Truck 

LDT2 - Dsl 
LDT2 - Gas 
LDT2 - Elec 
LDT2 - Phe 

LDT2 Light-Duty Trucks (GVWR <6000 lbs  and 
ETW 3751-5750 lbs) LDT2 LDT2 T2 Non-

Truck 
Non-
Truck 

MDV - Dsl 
MDV - Gas 
MDV - Elec 
MDV - Phe 

MDV Medium-Duty Trucks (GVWR 6001-8500 
lbs) MDV MDV T3 Non-

Truck 
Non-
Truck 

MH - Dsl 
MH - Gas MH Motor Homes MH MH MH Non-

Truck 
Non-
Truck 

MCY - Gas MCY Motorcycles MCY MCY MC Non-
Truck 

Non-
Truck 

LHD1 – Dsl 
LHD1 - Gas 
LHD1 - Elec 

LHD1 Light-Heavy-Duty Trucks (GVWR 8501-
10000 lbs) LHDT1 LHDT1 T4 Truck Truck1 

LHD2 – Dsl 
LHD2 - Gas 
LHD2 - Elec 

LHD2 Light-Heavy-Duty Trucks (GVWR 10001-
14000 lbs) LHDT2 LHDT2 T5 Truck Truck1 

T6 Public Class 4 - Dsl 
T6 Public Class 4 - Elec 
T6 Public Class 4 - NG 

T6 Public 
Class 4 

Medium-Heavy Duty Public Fleet Truck 
(GVWR 14001-16000 lbs) T6 Public MHDT T6 Truck Truck2 
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EMFAC202x 
veh & fuel 

EMFAC202x 
Vehicle 
Class 

Description 
EMFAC2011 

Vehicle 
Class*** 

EMFAC2007 
Vehicle 
Class 

EMFAC2007 
Vehicle 
Code 

Truck /
Non-
Truck 

Category 

Truck 
1 /

Truck 
2 

/Non-
Truck 

T6 Public Class 5 - Dsl T6 Public 
Class 5 

Medium-Heavy Duty Public Fleet Truck 
(GVWR 16001-19500 lbs) T6 Public MHDT T6 Truck Truck2 T6 Public Class 5 - Elec 

T6 Public Class 5 - NG 
T6 Public Class 6 - Dsl T6 Public 

Class 6 
Medium-Heavy Duty Public Fleet Truck 
(GVWR 19501-26000 lbs) T6 Public MHDT T6 Truck Truck2 T6 Public Class 6 - Elec 

T6 Public Class 6 - NG 
T6 Public Class 7 - Dsl T6 Public 

Class 7 
Medium-Heavy Duty Public Fleet Truck 
(GVWR 26001-33000 lbs) T6 Public MHDT T6 Truck Truck2 T6 Public Class 7 - Elec 

T6 Public Class 7 - NG 
T6 Utility Class 5 - Dsl T6 Utility 

Class 5 
Medium-Heavy Duty Utility Fleet Truck 
(GVWR 16001-19500 lbs) T6 Utility MHDT T6 Truck Truck2 T6 Utility Class 5 - Elec 

T6 Utility Class 5 - NG 
T6 Utility Class 6 - Dsl T6 Utility 

Class 6 
Medium-Heavy Duty Utility Fleet Truck 
(GVWR 19501-26000 lbs) T6 Utility MHDT T6 Truck Truck2 T6 Utility Class 6 - Elec 

T6 Utility Class 6 - NG 
T6 Utility Class 7 - Dsl T6 Utility 

Class 7 
Medium-Heavy Duty Utility Fleet Truck 
(GVWR 26001-33000 lbs) T6 Utility MHDT T6 Truck Truck2 T6 Utility Class 7 - Elec 

T6 Utility Class 7 - NG 
T6 Instate Tractor Class 6 - Dsl 

T6 Instate 
Tractor Class 
6 

Medium-Heavy Duty Tractor Truck 
(GVWR 19501-26000 lbs) 

T6 Instate 
small MHDT T6 Truck Truck2 T6 Instate Tractor Class 6 -

Elec 
T6 Instate Tractor Class 6 - NG 
T6 Instate Delivery Class 4 -
Dsl T6 Instate 

Delivery 
Class 4 

Medium-Heavy Duty Delivery Truck 
(GVWR 14001-16000 lbs) 

T6 Instate 
small MHDT T6 Truck Truck2 T6 Instate Delivery Class 4 -

Elec 
T6 Instate Delivery Class 4 -
NG 
T6 Instate Delivery Class 5 -
Dsl T6 Instate 

Delivery 
Class 5 

Medium-Heavy Duty Delivery Truck 
(GVWR 16001-19500 lbs) 

T6 Instate 
small MHDT T6 Truck Truck2 T6 Instate Delivery Class 5 -

Elec 
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EMFAC202x 
veh & fuel 

EMFAC202x 
Vehicle 
Class 

Description 
EMFAC2011 

Vehicle 
Class*** 

EMFAC2007 
Vehicle 
Class 

EMFAC2007 
Vehicle 
Code 

Truck /
Non-
Truck 

Category 

Truck 
1 /

Truck 
2 

/Non-
Truck 

T6 Instate Delivery Class 5 -
NG 
T6 Instate Delivery Class 6 -
Dsl 

T6 Instate 
Delivery 
Class 6 

Medium-Heavy Duty Delivery Truck 
(GVWR 19501-26000 lbs) 

T6 Instate 
small MHDT T6 Truck Truck2 T6 Instate Delivery Class 6 -

Elec 
T6 Instate Delivery Class 6 -
NG 
T6 Instate Other Class 4 - Dsl T6 Instate 

Other Class 4 
Medium-Heavy Duty Other Truck (GVWR 
14001-16000 lbs) 

T6 Instate 
small MHDT T6 Truck Truck2 T6 Instate Other Class 4 - Elec 

T6 Instate Other Class 4 - NG 
T6 Instate Other Class 5 -Dsl T6 Instate 

Other Class 5 
Medium-Heavy Duty Other Truck (GVWR 
16001-19500 lbs) 

T6 Instate 
small MHDT T6 Truck Truck2 T6 Instate Other Class 5 - Elec 

T6 Instate Other Class 5 - NG 
T6 Instate Other Class 6 – Dsl 

T6 Instate 
Other Class 6 

Medium-Heavy Duty Other Truck (GVWR 
19501-26000 lbs) 

T6 Instate 
small MHDT T6 Truck Truck2 T6 Instate Other Class 6 - Elec 

T6 Instate Other Class 6 - NG 
T6 Instate Tractor Class 7 - Dsl T6 Instate 

Tractor Class 
7 

Medium-Heavy Duty Tractor Truck 
(GVWR 26001-33000 lbs) 

T6 Instate 
heavy MHDT T6 Truck Truck2 T6 Instate Tractor Class 7 – 

Elec 
T6 Instate Tractor Class 7 - NG 
T6 Instate Delivery Class 7 -Dsl 

T6 Instate 
Delivery 
Class 7 

Medium-Heavy Duty Delivery Truck 
(GVWR 26001-33000 lbs) 

T6 Instate 
heavy MHDT T6 Truck Truck2 T6 Instate Delivery Class 7 -

Elec 
T6 Instate Delivery Class 7 -NG 
T6 Instate Other Class 7 - Dsl T6 Instate 

Other Class 7 
Medium-Heavy Duty Other Truck (GVWR 
26001-33000 lbs) 

T6 Instate 
heavy MHDT T6 Truck Truck2 T6 Instate Other Class 7 - Elec 

T6 Instate Other Class 7 - NG 
T6 CAIRP Class 4 - Dsl T6 CAIRP 

Class 4 

Medium-Heavy Duty CA International 
Registration Plan Truck (GVWR 14001-
16000 lbs) 

T6 CAIRP 
small MHDT T6 Truck Truck2 T6 CAIRP Class 4 - Elec 

T6 CAIRP Class 5 - Dsl MHDT T6 Truck Truck2 
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EMFAC202x 
veh & fuel 

EMFAC202x 
Vehicle 
Class 

Description 
EMFAC2011 

Vehicle 
Class*** 

EMFAC2007 
Vehicle 
Class 

EMFAC2007 
Vehicle 
Code 

Truck /
Non-
Truck 

Category 

Truck 
1 /

Truck 
2 

/Non-
Truck 

T6 CAIRP Class 5 - Elec T6 CAIRP 
Class 5 

Medium-Heavy Duty CA International 
Registration Plan Truck (GVWR 16001-
19500 lbs) 

T6 CAIRP 
small 

T6 CAIRP Class 6 - Dsl T6 CAIRP 
Class 6 

Medium-Heavy Duty CA International 
Registration Plan Truck (GVWR 19501-
26000 lbs) 

T6 CAIRP 
small MHDT T6 Truck Truck2 T6 CAIRP Class 6 - Elec 

T6 CAIRP Class 7- Dsl T6 CAIRP 
Class 7 

Medium-Heavy Duty CA International 
Registration Plan Truck (GVWR 26001-
33000 lbs) 

T6 CAIRP 
heavy MHDT T6 Truck Truck2 T6 CAIRP Class 7 - Elec 

T6 CAIRP Class 7 - NG 

T6 OOS Class 4 - Dsl T6 OOS 
Class 4 

Medium-Heavy Duty Out-of-state Truck 
(GVWR 14001-16000 lbs) 

T6 OOS 
small 

MHDT T6 Truck Truck2 

T6 OOS Class 5 - Dsl T6 OOS 
Class 5 

Medium-Heavy Duty Out-of-state Truck 
(GVWR 16001-19500 lbs) MHDT T6 Truck Truck2 

T6 OOS Class 6 - Dsl T6 OOS 
Class 6 

Medium-Heavy Duty Out-of-state Truck 
(GVWR 19501-26000 lbs) MHDT T6 Truck Truck2 

T6 OOS Class 7 - Dsl T6 OOS 
Class 7 

Medium-Heavy Duty Out-of-state Truck 
(GVWR 26001-33000 lbs) 

T6 OOS 
heavy MHDT T6 Truck Truck2 

T6TS - Gas T6TS Medium-Heavy Duty Truck T6TS MHDT T6 Truck Truck2 T6TS - Elec 
T7 Public Class 8 - Dsl 

T7 Public 
Class 8 

Heavy-Heavy Duty Public Fleet Truck 
(GVWR 33001 lbs and over) T7 Public HHDT T7 Truck Truck2 T7 Public Class 8 - Elec 

T7 Public Class 8 - NG 
T7 CAIRP Class 8 - Dsl T7 CAIRP 

Class 8 

Heavy-Heavy Duty CA International 
Registration Plan Truck (GVWR 33001 
lbs and over) 

T7 CAIRP HHDT T7 Truck Truck2 T7 CAIRP Class 8 - Elec 
T7 CAIRP Class 8 - NG 
T7 Utility Class 8 - Dsl T7 Utility 

Class 8 
Heavy-Heavy Duty Utility Fleet Truck 
(GVWR 33001 lbs and over) T7 Utility HHDT T7 Truck Truck2 T7 Utility Class 8 - Elec 

T7 NNOOS Class 8 - Dsl T7 NNOOS 
Class 8 

Heavy-Heavy Duty Non-Neighboring Out-
of-state Truck (GVWR 33001 lbs and 
over) 

T7 NNOOS HHDT T7 Truck Truck2 

T7 NOOS Class 8 - Dsl T7 NOOS 
Class 8 

Heavy-Heavy Duty Neighboring Out-of-
state Truck (GVWR 33001 lbs and over) T7 NOOS HHDT T7 Truck Truck2 
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EMFAC202x 
veh & fuel 

EMFAC202x 
Vehicle 
Class 

Description 
EMFAC2011 

Vehicle 
Class*** 

EMFAC2007 
Vehicle 
Class 

EMFAC2007 
Vehicle 
Code 

Truck /
Non-
Truck 

Category 

Truck 
1 /

Truck 
2 

/Non-
Truck 

T7 Other Port Class 8 - Dsl T7 Other Port 
Class 8 

Heavy-Heavy Duty Drayage Truck at 
Other Facilities (GVWR 33001 lbs and 
over) 

T7 Other 
Port HHDT T7 Truck Truck2 T7 Other Port Class 8 - Elec 

T7 POAK Class 8 - Dsl 
T7 POAK 
Class 8 

Heavy-Heavy Duty Drayage Truck in Bay 
Area (GVWR 33001 lbs and over) T7 POAK HHDT T7 Truck Truck2 T7 POAK Class 8 - Elec 

T7 POAK Class 8 - NG 
T7 POLA Class 8 - Dsl T7 POLA 

Class 8 
Heavy-Heavy Duty Drayage Truck near 
South Coast (GVWR 33001 lbs and over) T7 POLA HHDT T7 Truck Truck2 T7 POLA Class 8 - Elec 

T7 POLA Class 8 - NG 
T7 Single Concrete/Transit Mix 
Class 8 - Dsl T7 Single 

Concrete/Tra 
nsit Mix Class 
8 

Heavy-Heavy Duty Single Unit 
Concrete/Transit Mix Truck (GVWR 
33001 lbs and over) 

T7 Single HHDT T7 Truck Truck2 T7 Single Concrete/Transit Mix 
Class 8 - Elec 
T7 Single Concrete/Transit Mix 
Class 8 - NG 
T7 Single Dump Class 8 - Dsl T7 Single 

Dump Class 
8 

Heavy-Heavy Duty Single Unit Dump 
Truck (GVWR 33001 lbs and over) T7 Single HHDT T7 Truck Truck2 T7 Single Dump Class 8 - Elec 

T7 Single Dump Class 8 - NG 
T7 Single Other Class 8 - Dsl T7 Single 

Other Class 8 
Heavy-Heavy Duty Single Unit Other 
Truck (GVWR 33001 lbs and over) T7 Single HHDT T7 Truck Truck2 T7 Single Other Class 8 - Elec 

T7 Single Other Class 8 - NG 
T7 Tractor Class 8 - Dsl 

T7 Tractor 
Class 8 

Heavy-Heavy Duty Tractor Truck (GVWR 
33001 lbs and over) T7 Tractor HHDT T7 Truck Truck2 T7 Tractor Class 8 - Elec 

T7 Tractor Class 8 - NG 
T7 SWCV Class 8 - Dsl T7 SWCV 

Class 8 

Heavy-Heavy Duty Solid Waste 
Collection Truck (GVWR 33001 lbs and 
over) 

T7 SWCV HHDT T7 Truck Truck2 T7 SWCV Class 8 - Elec 
T7 SWCV Class 8 - NG 
T7IS - Gas T7IS Heavy-Heavy Duty Truck T7IS HHDT T7 Truck Truck2 T7IS - Elec 
PTO - Dsl PTO Power Take Off PTO HHDT T7 Truck Truck2 PTO - Elec 
SBUS - Gas SBUS School Buses SBUS SBUS SB 
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EMFAC202x 
veh & fuel 

EMFAC202x 
Vehicle 
Class 

Description 
EMFAC2011 

Vehicle 
Class*** 

EMFAC2007 
Vehicle 
Class 

EMFAC2007 
Vehicle 
Code 

Truck /
Non-
Truck 

Category 

Truck 
1 /

Truck 
2 

/Non-
Truck 

SBUS - Dsl Non-
Truck 

Non-
Truck SBUS - Elec 

SBUS - NG 
UBUS - Dsl 

UBUS Urban Buses UBUS UBUS UB Non-
Truck 

Non-
Truck 

UBUS - Gas 
UBUS - Elec 
UBUS - NG 
Motor Coach - Dsl Motor Coach Motor Coach Motor Coach OBUS OB Non-

Truck 
Non-
Truck Motor Coach - Elec 

OBUS - Gas OBUS Other Buses OBUS OBUS OB Non-
Truck 

Non-
Truck OBUS - Elec 

All Other Buses - NG All Other 
Buses All Other Buses All Other 

Buses OBUS OB Non-
Truck 

Non-
Truck All Other Buses - Dsl 

* GVWR: gross vehicle weight rating 
** ETW: equivalent test weight 
*** Some of the EMFAC2011 vehicle classes, including T6 Ag, T6 Instate Construction Heavy, T6 Instate Construction Small, T7 Ag, T7 Single 
Construction and T7 Tractor Construction, are reallocated to other EMFAC202x vehicle classes. Details are discussed in the technical 
documentation. 

70 



 
 

 
 

    
   

 
  

  

 
     

   
 

 

      

   

   

 

  

EMFAC2021 User’s Guide 

APPENDIX 5 SUMMARY OF RUN PARAMETERS FOR GENERATING CUSTOM ACTIVITY TEMPLATE 
Tab Run Parameters Description 

Area Type One of the area types can be picked. 
Area 

Area One or more areas can be selected for one run. 

Calendar Year Between 2000 and 2050. One or more calendar years can be selected for one run. 
Time One of the three seasons (annual, summer, winter) or one of the 12 months can be Season/Month selected for one run. 

VMT Type Whether input VMT is by daily total or by vehicle and fuel type. 

VMT Hourly Speed Fractions Whether to include custom hourly speed fractions. 

SB375 Whether it is a SB375 template. 
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APPENDIX 6 SUMMARY OF RUN PARAMETERS FOR GENERATING CUSTOM ACTIVITY EMISSIONS 
INVENTORY 

Tab Run Parameters Description 

Template File Type Whether it is EMFAC2021 format or EMFAC2017 Format. 

Load SB375 Whether it is a SB375 run 

Custom Activity File The custom activity file in EMFAC2021 or EMFAC2017 format. 

One or more of the reports (csv, planning inventory, or CTF) can be generated for aReport Type non-SB375 run. 

Report Type (SB375) Only SB375 planning inventory report will be generated. Output 
Save data for future use Users can get results faster in the future if data from previous runs are saved and used. 

Output Directory Where to save output files. 
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APPENDIX 7 SUMMARY OF RUN PARAMETERS FOR GENERATING EMISSION RATES 
Tab Run Parameters Description 

Area Type One of the area types can be picked. 
Area 

Area One or more areas can be selected for one run. 

Calendar Year Between 2000 and 2050. One or more calendar years can be selected for one run. 
Time One of the three seasons (annual, summer, winter) or one of the 12 months can be Season/Month selected for one run. 

Output by EMFAC202x vehicle class, EMFAC2011 vehicle class, EMFAC2007 vehicle Vehicle Class type class, Truck/non-Truck or Truck1/Truck2/non-Truck. 

Vehicle Class One or more vehicle classes can be picked for one run. 

Vehicles Aggregated or by model year in output.  One or more model years can be selected if by Model Year model year is selected. 

Fuel Aggregated or by fuel in output. 

Speed One or more speeds can be selected. 

Temperature Temperature in Fahrenheit. 
Meteorology 

Relative Humidity Relative humidity. 

Pollutants Pollutants in output. 
Output 

Output Directory Where to save output files. 
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APPENDIX 8 FIELDS IN CTF FILE 
FIELD NAME FIELD TYPE LENGTH FIELD DESCRIPTION 

YEAR NUMERIC 4 CAL YEAR OF THE RUN DATA 
DIS CHAR 3 DISTRICT ID 
AB CHAR 3 AIR BASIN ID 
CO NUMERIC 2 COUNTY ID 
EIC NUMERIC 14 EIC CODE 
PR NUMERIC (11,2) 11 ANNUAL PROCESS RATE 
HPDY NUMERIC 2 HOURS PER DAY 
DPWK NUMERIC 2 DAY PER WEEK 
JANT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR JANUARY - RANGE 0-100 
FEBT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR FEBRUARY - RANGE 0-100 
MART NUMERIC(4,1) 5 PERCENT ACTIVITY FOR MARCH - RANGE 0-100 
APRT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR APRIL - RANGE 0-100 
MAYT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR MAY - RANGE 0-100 
JUNT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR JUNE - RANGE 0-100 
JULT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR JULY - RANGE 0-100 
AUGT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR AUGUST - RANGE 0-100 
SEPT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR SEPTEMBER - RANGE 0-100 
OCTT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR OCTOBER - RANGE 0-100 
NOVT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR NOVEMBER - RANGE 0-100 
DECT NUMERIC(4,1) 5 PERCENT ACTIVITY FOR DECEMBER - RANGE 0-100 
POL NUMERIC 9 POLLUTANT CODE 
EMFACT NUMBER (10,4) 11 EMISSION FACTOR (LBS PER EIC UNIT) 
SEASON CHAR 14 SEASON 
EMS NUMERIC(10,4) 11 EMISSIONS (TONS/DAY) 
VERSION CHAR 15 EMFAC VERSION 
OPERATOR CHAR 3 OPERATOR INITIALS 
TDATE DATE 8 TRANSACTION DATE 
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